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 About VR Scout
Chaco VR Scout 1.1 is a Windows VRML viewer which works with any web browser supporting 
the DDE interface.    VR Scout can also run as a stand-alone application.    A VRML file has the 
suffix ".wrl".    VR Scout allows you to move through a 3D scene, looking at objects from arbitrary 
angles.    Objects can be tagged with URL addresses, letting you to click on an object to load 
another VRML scene or HTML page.

Supported features

Integrated with Web Browsers

Because VR Scout includes support for the viewer DDE interface, web browsers can be 
configured to bring up VR Scout automatically when a VRML file is encountered.    Compatible 
web browsers include NetManage WebSurfer, Netscape Navigator, Microsoft Internet Explorer 
and others.

Internal Support for HTTP

VR Scout includes internal support for HTTP, so it can be run standalone to view VRML files 
locally or on the net.

Multi-Threaded

VR Scout is multi-threaded.    Individual objects and textures in a scene may be represented by 
separate files from different places on the Internet.    When invoked by some browsers, including 
WebSurfer, and when running standalone, VR Scout will download several objects 
simultaneously, using multiple execution threads.    This helps deliver the entire scene to you 
faster.

Tight Code

VR Scout 1.1 is less than 1 MB, including the 3DR rendering libraries it installs.

Partial Scene Display

As VR Scout downloads each object, it appears in the scene.    This allows you to view the 
general scene as individual patterns and objects are downloaded.

Fast Navigation

VR Scout has the option to use "flat shading" to represent objects as you are navigating through a
scene.    This improves the speed of navigation.

Option Settings in Registry

As with all 32-bit Windows compliant applications, VR Scout uses the new Windows registry to 
store option and configuration information.

Anchors



Object may contain an anchor (a pointer to another location on the Web).    When you move the 
mouse over an anchor, it will change to a hand-cursor.    A description of the anchor appears in the
status line below the VR Scout window.    If you click on the anchor, its URL is downloaded and 
displayed.    Note that anchors pointing to another VRML scene will cause VR Scout to display 
that scene, while other anchors will cause your web browser to load a new page.

More Texture Types

Texture maps, color patterns tiled or placed on an object, can be supplied as either JPEG, GIF, 
and Microsoft BMP files.

Level-of-Detail (LOD) Supported

Level-of-detail allows a scene to designate different objects to appear depending on your distance
from the scene.    This allows a chess board to appear fuzzy (and fast to render) while you are far 
away, then when you approach the pieces appear on the chess board.

WWWInline

VR Scout supports nested WWWInline operations.    This node is used to compose a scene from 
several independent object files.    VR Scout renders WWWInline images as they become 
available through the network.

Other Supported Features

Multiple lights, background and viewer-mode hints.

Content-Encoding

If the HTTP server supports content-encoding, VR Scout can decode .ZIP files.



 About Chaco Communications, Inc.
Chaco builds multimedia social software.    We're nice folk, and we do great things.    We want to 
make the world a better place by bringing people together.

If you're interested in using VRML in a multi-user environment, check out Pueblo, another Chaco 
Communications product.    Pueblo is available from:

http://www.chaco.com/

You can also send us electronic mail or write us.    We'd love to hear from you.

Electronic mail: info@chaco.com

Telephone: 408.996.1115

United States Postal 
Service:

Chaco Communications, Inc.
10164 Parkwood Drive, Suite 8
Cupertino, CA    95014-1533
USA

How to...

· Install VR Scout
· Move through a 3D scene
· Reset my view in the scene
· Speed up drawing scenes

How to install VR Scout
If VR Scout isn't configured and doesn't automatically appear when you visit a VRML scene, then 
this section tells you how to manually configure the viewer.

Manual Configuration for WebSurfer

First start WebSurfer.    Next select the 'Preferences' menu entry in the 'Settings' menu.    Click on 
the 'Viewers' tab, click the 'Add' button, and use these values for these fields:

MIME Type: x-world/x-vrml

Extension: wrl

Viewer: VRScout.exe

Note that if 'VRScout.exe' is not in your path, you may need to specify the full path to the 
executable or click the 'Browse' button, locate the executable, and click 'OK'.

Then click 'OK', and the VRML browser should be configured and shown in the 'Document 
Viewers:' list.    Click 'OK' again to finalize the new browser.





How to reset your view into a scene
Sometimes it's possible to get lost in a scene.    If this happens to you, and you want to quickly go 
back to your starting point in the scene, select 'Reset Camera' from the 'View' menu.



How to speed up drawing scenes
Go to the 'Preferences' item under the 'Options' menu, and click on the '3D Graphics' tab.    Try 
changing the "When standing still" and "When moving" selections to get the drawing to go as fast 
as you like.    In general, the speed increases in this order:

· Smooth shading (slowest, but looks the best)
· Scene default
· Flat shading (fastest, looks the worst)

Another way to speed up VR Scout's drawing is to decrease the number of colors your display 
uses (in the control panel's "Display" item).    It takes twice as long to move around 16-bit color as 
it does to move around 8-bit color.

VR Scout uses Intel's 3dr rendering library, so you could always get a polygon accelerator card 
(Several will be released over the next few months, some of them not that expensive.) which has 
drivers for 3dr.    VR Scout will recognize that you have the card and speed up.



Menus



File menu commands
The File menu offers the following commands:

Open Location... Open a document located on the world wide 
web.

Open File... Open a local VRML file.

Save As... Saves the active document with a new name.

Exit Exits VR Scout.

View menu commands
The View menu offers the following commands:

Reload Reloads the current document.

Refresh Redraws the current document.

Reset Camera Resets your camera to the starting location.

Examine Changes your viewing mode to 'Examine', 
used for manipulating objects.

Walk Changes your viewing mode to 'Walk', used 
for walking through scenes.

Fly Changes your viewing mode to 'Fly', used for 
flying through scenes.

Show Source... Displays the current VRML source file.

Go menu commands
The Go menu offers the following commands:

Back Returns to the previously loaded document.

Forward Returns to the next document.

Home Returns to the home page.

Stop Loading Stops loading the current document.

Options menu commands
The Options menu offers the following commands:

Preferences... Change user preferences for VR Scout.

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Headlight This option turns your headlight on and off.

Brighter This option turns up your headlight.



Dimmer This option turns down your headlight.

Move Faster Increases the distance of keyboard 
movement.

Move Slower Decreases the distance of keyboard 
movement.

Help menu commands
The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you 
can get help.

Using Help Provides general instructions on using help.

About VR Scout... Displays information on VR Scout.

Open Location... command (File menu)
Use this command to open a location on the world-wide web.    A dialog with an edit field will 
appear.    Enter the URL (Universal Resource Locator) and press the 'Open' button.

URLs usually start with 'http://' and specify a location for information on the Web.

Shortcuts

Toolbar:



Open File... command (File menu)
Use this command to open a file that is either on your machine or on your local network.    A 
standard open-file dialog will appear, and you can select the file you wish to open.



Save As... command (File menu)
Selecting this menu item while looking at a VRML scene allows you to save the scene to a local 
file.    A standard file-save dialog box will appear.    Select the directory where you want to save the
file, and type in a file name.

Note

VRML scenes are often composed of more than just the VRML file itself.    Most scenes paste 
'patterns' or bitmap files to the walls to give a richer texture.    When you save a VRML scene 
using the 'Save As...' command, only the VRML text will be saved to the file.



Exit command (File menu)
Use this command to end your VR Scout session.    You can also use the Close command on the 
application Control menu.

Shortcuts

Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Reload command (View menu)
This command will reload the current document from the source.    This is useful for documents 
that are continuously updated over time, but not automatically reloaded into VR Scout.



Refresh command (View menu)
This command will redraw (but not reload) the current document.



Reset Camera command (View menu)
This command will move your point of view (the camera) to where it was when the view was first 
loaded.    This command is very useful when you get hopelessly lost in a complex VRML scene.



Examine command (View menu)
This command will change to 'Examine' mode, which allows you to manipulate the scene as an 
object.

Shortcuts

Keys: Ctrl + E

Also see

Moving through 3d space



Walk command (View menu)
This command will change to 'Walk' mode, which allows you to move through the scene as 
though you were walking.    Generally, your viewpoint is kept the same distance from the 'floor' of 
the scene you're viewing.

Shortcuts

Keys: Ctrl + W

Also see

Moving through 3d space



Fly command (View menu)
This command will change to 'Fly' mode, which allows you to move through the scene as though 
you were wearing a jet pack.    Moving forward always moves you in the direction that you're 
looking, even if that is upwards.

Shortcuts

Keys: Ctrl + F

Also see

Moving through 3d space



Show source... command (View menu)
This item will open a dialog containing the source for the current VRML image.    You can scroll 
through the source.    You may also select and copy text to paste into another application.

When you are finished viewing source, press the 'Okay' button.



Back command (Go menu)
This command will move you to the VRML scene you viewed immediately before viewing the 
current scene.    (This command will be unavailable unless you've looked at more than one VRML 
scene.)

Shortcuts

Toolbar:

Keys: Alt + <



Forward command (Go menu)
This command is the opposite of the Back command.    If you've backed up to a previously-viewed
scene, this command will move you forward again.    (This command will be unavailable unless 
you've used the Back command.)

Shortcuts

Toolbar:

Keys: Alt + >



Home command (Go menu)
If you've set a home page using the Preferences menu item, this command will return you your 
home location.    Your home will be loaded by your browser, so it may be HTML, VRML, or any 
other type of file that your browser supports.

Shortcuts

Toolbar:



Stop Loading command (Go menu)
This command will stop loading an image.    If possible, the partial image will be displayed.

Shortcuts

Toolbar:



Preferences... command (Options menu)
This menu item will allow you to set preferences for viewing VRML images.    Among other things, 
you can use this item to set the brightness of your headlight, optimize movement to be faster, and
set the default home page for VR Scout.



Toolbar command (Options menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in VR Scout, such as Open Location.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Status Bar command (Options menu)
Use this command to display and hide the Status Bar, which describes the action to be executed 
by the selected menu item or depressed toolbar button as well as download progress.    A check 
mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Headlight command (Options menu)
In a VRML scene, imagine yourself as a miner, wearing a hard-hat and a lamp.    This command 
toggles your lamp on and off.    Normally your headlamp should be off.    Occasionally, however, a 
scene may be too dark.    If this is the case, then this command will give you the extra light you'll 
need to find your way around.



Brighter command (Options menu)
This command turns up the brightness of your headlamp.    This command is unavailable if the 
headlamp is already turned all the way up or if you haven't yet loaded a VRML scene.

If your headlamp is turned off, this command will increase the value of the headlamp but will not 
have a visual effect (until you turn your headlamp on again.)

Shortcuts

Keys: Ctrl + B



Dimmer command (Options menu)
This command turns down the brightness of your headlamp.    This command is unavailable if the 
headlamp is already turned all the way down or if you haven't yet loaded a VRML scene.

If your headlamp is turned off, this command will decrease the value of the headlamp but will not 
have a visual effect (until you turn your headlamp on again.)

Shortcuts

Keys: Ctrl + D



Move Faster command (Options menu)
The keyboard may be used to move through a scene.    Selecting this menu command increases 
the length of each virtual step.

Shortcuts

Keys: + (on the numeric keypad)



Move Slower command (Options menu)
The keyboard may be used to move through a scene.    Selecting this menu command decreases 
the length of each virtual step.    There is a fixed minimum, so you'll never get to where you can't 
move using the keyboard (though it may seem that way.)

Shortcuts

Keys: - (on the numeric keypad)



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can 
jump to step-by-step instructions for using VR Scout.

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
This command shows a dialog box which contains information about VR Scout.    Among other 
information, this displays the version number and copyright notice for the viewer.



Context Help command

Use the Context Help command to obtain help on some portion of VR Scout.    When you choose 

the Toolbar's Context Help button, the mouse pointer will change to .    Then click somewhere 
in the VR Scout window, such as another Toolbar button or a menu item.    The Help topic will be 
shown for the item you clicked.

Shortcut

Keys: SHIFT+F1



User Interface



The VR Scout user interface

(You may click on this picture to get help on parts of the user interface.)

VR Scout uses the standard Windows interface.    There are menus, a tool bar, and a status bar.    
The central part of the window shows a view into any loaded VRML scene.

VR Scout is a viewer application, which means that it is intended to use with a web browser.    
When you install VR Scout into your browser, the browser will automatically launch VR Scout 
when a hotlink leads to a VRML scene.    (For more information click on 'How to install VR Scout' 
below.)

By using either the mouse or keyboard, you can move around within the scene.    When you move
the mouse cursor over an object and it changes from an arrow to a hand, you can click on that 
object to perform some action.    (This usually jumps to a another location.)    In addition, the status
bar will display information on where clicking will take you.

If a scene appears to be black or very dark, you need to turn on your headlight.    This is done by 
selecting 'Headlight' from the 'Options' menu.

You can have several VR Scout windows open at a time.    Each VR Scout window will display its 
own loaded scene.    It's also okay to have two or more VR Scout windows displaying the same 
scene.

Also see

How to install VR Scout

Background on VRML

Moving through 3d space

The menu bar (on the contents page)

The toolbar

The status bar



The Headlight command



Toolbar

(You may click on this picture to get help on parts of the toolbar.)

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to VR Scout functions,

To hide or display the Toolbar, choose Toolbar from the Options menu.



Status Bar

(You may click on this picture to get help on parts of the status bar.)

The status bar is displayed at the bottom of the VR Scout window.    To display or hide the status 
bar, use the Status Bar command in the Options menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description of 
the toolbar button command you wish not to execute the command, then release the mouse 
button while the pointer is off the toolbar button.



Title Bar
The title bar is located along the top of a window.    It contains the name of the application and 
document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their 
title bars.

The title bar contains the following elements:

· Application Control-menu button
· Name of the application
· The name of any file being displayed
· Maximize button
· Minimize button
· Restore button



Scroll bars
Displayed at the right and bottom edges of the document window.    The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the document.    You can use the mouse
to scroll to other parts of the document.



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to 
move the pointer to the border you want to move.

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut

Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or dialog 
box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut

Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the VR Scout window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.

Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.

Keys: CTRL+F10 enlarges a document window.



 Next Window command (document Control menu)
Use this command to switch to the next open document window.    VR Scout determines which 
window is next according to the order in which you opened the windows.

Shortcut

Keys: CTRL+F6



 Previous Window command (document Control menu)
Use this command to switch to the previous open document window.    VR Scout determines 
which window is previous according to the order in which you opened the windows.

Shortcut

Keys: SHIFT+CTRL+F6



 Close command (Control menus)
Use this command to close the active window or dialog box.    Double-clicking a Control-menu box
is the same as choosing the Close command.

Shortcuts

Keys: ALT+F4 closes VR Scout.



 Restore command (Control menu)
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this 'Task List' to switch to or 
close an application on the list.

Shortcut

Keys: CTRL+ESC

Dialog Box Options

When you choose the Switch To command, you will be presented with a dialog box with the 
following options:

Task List Select the application you want to switch to or close.

Switch To Makes the selected application active.

End Task Closes the selected application.

Cancel Closes the Task List box.

Cascade Arranges open applications so they overlap and you
can see each title bar.    This option does not affect 
applications reduced to icons.

Tile Arranges open applications into windows that do not
overlap.    This option does not affect applications 
reduced to icons.

 Arrange Icons Arranges the icons of all minimized applications 
across the bottom of the screen.

Dialog boxes



The About box
This dialog has several pages of information on VR Scout.    You can click your mouse on one of 
the tabs at the top of the window to go to that page.



Popup definitions



    VRML stands for Virtual Reality Modeling Language, and is a format for describing 3D scenes.



HTML (HyperText Markup Language) is the language used to define the structure of hypertext documents
on the World-Wide Web. HTML documents are in plain (also known as ASCII) text format and can be 
created using any text editor.



TCP/IP stands for Terminal Control Protocol / Internet Protocol.    This is the main means of 
communications between machines on the internet.



SLIP stands for Serial Line Internet Protocol, and is used to connect to an internet provider using a serial 
line (a modem, for instance.)    SLIP is a wrapper around the TCP/IP protocol.



PPP stands for Point-to-Point Protocol, and is used to connect to an internet provider using a serial line (a
modem, for instance.)    PPP is a wrapper around the TCP/IP protocol.



Dialog box pop-ups



This button will cancel the dialog without making any changes.



This button will display help for the dialog (this help page.)



Displays information about VR Scout.



Allows you to get context sensitive help on the application.    The cursor changes to  and Help will be 
displayed for the next thing you select.



This field displays information and messages that help you use VR Scout.    When the mouse is over a 
menu item help will be displayed on that menu.



This field contains a display of the progress of any network transfers.    As a transfer approaches 
completion, the field will fill with color.    (The example shows a transfer about 3/4 done.)    When no 
transfers are underway, the field is empty (and in the background color.)



This command will move you to the scene you viewed immediately before viewing the current scene.    
(This command will be unavailable unless you've looked at more than one scene.)



If you've backed up to a previously-viewed scene, this command will move you forward again.    (This 
command will be unavailable unless you've used the Back command.)



This button will load your home page.    (The button is unavailable unless you specified a home page 
using the Preferences menu item.)



This button will allow you to open a specific location on the web by entering the Universal Resource 
Locator (URL).



This button will stop any transfer in progress.



This is where the current VRML scene is displayed.    You can also move around within the scene by 
clicking the mouse in this window.



This is the menu bar for the application.



Miscellaneous



No Help Available
No help is available for this area of the window.



No Help Available
No help is available for this message box.





Background on the Virtual Reality Modeling Language

by Mark Pesce (March 1995)    (used with permission)

The Virtual Reality Modeling Language (VRML) is a language for describing multi-user interactive 
simulations -- virtual worlds networked via the global Internet and hyperlinked within the World 
Wide Web.

In 1969, the creation of ARPAnet, the forerunner of today's Internet, provided a methodology 
through which users could remotely manipulate computers, and the files stored on them.    While 
this was a powerful extension of computing, it was also confusing; without any clear sense of 
"what went where", access to Internet was restricted to the class of early "net surfers" who could 
remember where things were stored.    Most everyone else, even technically sophisticated users 
of computers, found it impossible to make sense of it.

In 1989, Tim Berners-Lee, a software engineer at the Center for European Particle Physics, 
CERN, developed a hypermedia system today known as the World Wide Web.    With the creation
of the Universal Resource Locator, or URL, it became possible to tell anyone "where to go and 
how to get there" for almost any piece of data on the Internet.    Rather than a cryptic set of 
commands and accesses, the URL created a standard addressing mechanism for the data hidden
in cyberspace.    In essence, it turned the entire Internet into the equivalent of a single (very large)
disk drive, and made it possible to create documents which could encompass data from many 
different parts of the Internet, binding them together into a cohesive whole.

Even the URL required some improvement.    They're quite cryptic - for example, I can only tell 
you how to get to the VRML Forum home page by saying, "http://vrml.wired.com/", which is not 
really human-centered data, it's computer-centered data.    I need to make an effort to remember it
at all.    As great as it is, the URL mechanism of the World Wide Web leaves a lot to be desired, 
particularly for human beings, and we comprise the user base; the Web was built for people, not 
for computers, and because of this, the Web has caused an enormous upsurge in Internet traffic.  
Very soon, the bulk of the traffic on the Internet will be Web-generated.

A few years ago, research into "sensualized" interfaces began to receive widespread attention in 
the press and the industry.    A wide range of technologies, which collectively came to be known 
as "Virtual Reality", began a fundamental change in the nature of the user interface, moving it to a
human-centered design; where the space around the user became the computing environment, 
and the entire sensorium was engaged in the interface.    All of this was in an effort to make 
computers more responsive to the humans who used them, and focused around a basic 
realization:    if something is represented sensually, it is possible to make sense of it.

Late in 1993, Mark Pesce, and Tony Parisi developed a three-dimensional interface to the Web 
which embodied many of the lessons learned in several years of research in both virtual reality 
and networking.    Upon communicating these innovations to Berners-Lee, Pesce was invited to 
present a paper at the First International Conference on the World Wide Web, in Geneva, 
Switzerland.    During a session to discuss virtual reality interfaces to the Web, attendees agreed 
there was a need for a common language to specify 3D scene description and WWW hyperlinks 
-- an analog of HTML for virtual reality.    The term Virtual Reality Modeling Language (VRML) was
coined, and the group (headed by Pesce and Brian Behlendorf, of WIRED magazine) began work
on a VRML specification immediately following the conference.

With the blessing of WIRED, Behlendorf set up an electronic mailing list to facilitate discussion of 



a specification for VRML.    The response was overwhelming; within a week, there were over a 
thousand members.    The list membership quickly agreed upon a set of requirements for VRML, 
and began a search for technologies which could be adapted to fit the needs of it.

The list members proposed several worthwhile candidates, and after much deliberation the list 
came to a consensus: the Open Inventor ASCII File Format from Silicon Graphics, Inc.    The 
Inventor File Format supports complete descriptions of 3D scenes with polygonally rendered 
objects, lighting, materials, ambient properties and realism effects.    It has all of the features that 
professionals need to produce high-quality work, and an existing tools base with a wide installed 
presence.

A subset of the Inventor File Format, with extensions to support networking, forms the basis of 
VRML.    Gavin Bell of Silicon Graphics has adapted the Inventor File Format for VRML, with 
design input from the mailing list.    SGI has publicly stated that the file format is available for use 
in the open market, and has contributed a file format parser into the public domain to bootstrap 
VRML viewer development.

VRML is designed to meet three criteria:    platform independence; extensibility; and the ability to 
work over low-bandwidth (14.4 kBps modem) connections.    Early on, the designers decided that 
VRML would not be an extension to HTML, which is designed for text, not graphics.

The next generation of Web browsers will understand and interpret VRML; here are three 
examples of the kinds of projects VRML will enable:

The Interactive Media Festival Gallery Tour

The Interactive Media Festival (http://www.arc.org/) is an annual event of world-wide scope, which
attracts some of the best talents of the new media.    Their annual gallery and awards event, 
which takes place in Los Angeles in early June, will also be modeled in VRML and linked into their
own Web site.    People anywhere in the world will be able to tour the gallery space, examine the 
contestants' works, and follow links from these works other items of interest.    In this way, IMF 
can have an international scope and an international reach.

WaxWeb 2.0

David Blair, the avant-garde filmmaker of WAX: or The Discovery of Television Among the Bees, 
and Tom Meyer, a doctoral candidate at Brown University, spent the last two years developing 
WaxWeb (http://bug.village.virginia.edu), a hypermedia web version of the film.    David and Tom 
have spent the last 8 months bringing WaxWeb forward into VRML; at the release of WaxWeb 2.0
in the beginning of April, it acquires a VRML component - when a user goes to the WaxWeb 
VRML site, WaxWeb generates an assortment of rooms and links - but no two journeys through 
WaxWeb are ever completely the same.    At last count, they'd created over 9000 (!) possible 
rooms to walk through, each of which is rich with content and anchors.

Virtual SoMa

The heart of the nation's multimedia industry is San Francisco's "Multimedia Gulch", located in its 
"South of Market" neighborhood, nicknamed SoMa.    Several organizations have initiated a 
project to model SoMa in VRML and make it accessible through the Web.    As a pilot, the 10-
block area between 1st and 3rd Streets, from Howard to King, is being modeled as a VRML 
world.    Many of the organizations in this neighborhood already have a web presence; this model 
links to their web pages.    You can take a stroll down the virtual 3rd Street, to the block between 
Bryant and Brannan, find the offices of WIRED, click on the building, and go to their home page in
the web.

There are some areas where VRML is still incomplete.    Except for the hyperlinking feature, the 



first version of VRML does not support interactive behaviors.    This was a practical decision 
intended to streamline design and implementation.    Design of a language for describing 
interactive behaviors is a big job, particularly when the language needs to express behaviors of 
objects communicating on a network.    Support for arbitrary interactive behaviors is critical to the 
long-term success of VRML; it will be included in the second revision of the VRML specification, 
which will be completed by December of 1995.

Mark D. Pesce
Moderator of the VRML mailing list

mpesce@netcom.com

Other Resources

The following pages are good places to look for more information on VRML:
· The Wired Magazine VRML forum (http://vrml.wired.com/)
· The VRML Repository (http://www.sdsc.edu/vrml)
· The VRML Suppository (http://www.virtpark.com/theme/supp/)

is fun and definitely interesting.



How to move through a VRML scene
You can move through a VRML scene using either the mouse or the keyboard.    How movement 
works depends on what movement mode you are using.

Walk mode

Walk mode is very similar to being in the scene and walking around.

Mouse controls

To use the mouse, click on the scene and move the mouse in the direction you want to walk.    
Dragging in a direction has the following effects:

Normally, dragging the mouse 'walks' you 
around in the world.

When the Control key is pressed, you can 
use the mouse to look up and down.

When the Shift key is pressed, your position 
is shifted from where you are standing, but 
your orientation isn't changed.

You can also drag diagonally to combine movements.    The further you move away from where 
you originally clicked, the faster you will move.    The 3D Graphics preferences dialog allows you 
to degrade the quality of the image while moving, so that you move faster (but things don't look as
good while you're moving.)

Keyboard controls

The keyboard movements in Walk mode are as follows:

This key: Does this: With the Shift pressed
it does this:

With the Control
pressed it does this:

¬ Turn left Shift left
® Turn right Shift right

Walk forward Shift up Look up
¯ Back up Shift down Look down

These all work the same as described for the mouse controls above.

Fly mode

Fly mode is like being in an airplane.    This airplane is really great... it can even hover and fly 
backwards.    You move in whatever direction your nose is pointing.    If you look up at the sky and 
then move forward, you start climbing.    In addition in fly mode you can tilt the view from side to 
side.

Mouse controls



To use the mouse, click on the scene and move the mouse in the direction you want to walk.    
Dragging in a direction has the following effects:

Normally, dragging the mouse flies you 
around in the world.

When the Control key is pressed, you can 
use the mouse to look up and down as well 
as tilt left and right.

When the Shift key is pressed, your position 
is shifted from where you are standing, but 
your orientation isn't changed.

You can also drag diagonally to combine movements.    The further you move away from where 
you originally clicked, the faster you will move.    The 3D Graphics preferences dialog allows you 
to degrade the quality of the image while moving, so that you move faster (but things don't look as
good while you're moving.)

Keyboard controls

The keyboard movements in fly mode are as follows:

This key: Does this: With the Shift pressed
it does this:

With the Control
pressed it does this:

¬ Turn left Shift left Tilt left
® Turn right Shift right Tilt right

Fly forward Shift up Look up
¯ Fly backwards Shift down Look down

These all work the same as described for the mouse controls above.

Examine mode

Examine mode is for looking at objects modeled in VRML.    Rather than moving through a scene, 
examine mode is like holding an object in your hand and turning and twisting it to look at it 
carefully.    You can also move the object closer and further away from your eyes.

Imagine the entire scene to be contained in a big glass ball, which is right in front of you.    By 
spinning this ball, you can look at all sides of the scene or object.    To spin the ball, use the 
mouse to 'grab' a point, and spin the ball around, much as you would a large trackball.    The 
program attempts to keep the same point of the ball under the mouse cursor.

You can also zoom in or move around using the arrow keys.    These do not affect the center of 
rotation.    That is always defined by the sphere enveloping the world.

Probably the best way of using the examine interface is to rotate the object by grabbing it and 
rotating it using the mouse, and using the up and down keys to move in and move away from the 
object.

Mouse controls



As described above:

Dragging the mouse rotates the object you're 
examining:

Keyboard controls

The keyboard movements in examine mode are as follows:

This key: Does this: With the Shift pressed
it does this:

With the Control
pressed it does this:

¬ Turn left Shift left Rolls the object left
® Turn right Shift right Rolls the object right

Move towards the
object

Shift up Rolls the object up

¯ Move away from
the object

Shift down Rolls the object down




